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AVAILABLE DATA

e Cadaster (national, land use, but not up to date)
* CORINE land cover (EEA, land cover, coarse resolution, last in 2006)

» StatGIS (National Statistical office, Landsat images, land cover, coarse
resolution, last in 2005)

 Survey of SFIl for 1986 — 2005 (national, sampling, ortophoto images, land use,
agreggated categories)

 Agricultural land use map (ALUM) (national, Ministry of agriculture and
environment, whole county, vector data, ortophoto images, field visits, land
use, continuously from 2002)
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AGRICULTURAL LAND USE MAP

* Ministry of Agriculture and Environment

* Actual land use

e Continuously from 2002 ->

* Ortophoto images, other national data, field visits
* Publicly available

* http://rkg.gov.si/GERK/WebViewer/
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ALUM CATEGORIES

Category description

National class ID

1100 Arable land
1130 Temporary meadows
1160 Hop fields
1180 Other permanent crops on arable land
1190 Green houses
1211 Vineyards
1212 Nursery
1221 Intensive orchards
1222 Extensive orchards
1230 Olive groves
1240 Other permanent crops
1300 Meadows and pastures
1321 Swampy meadows and pastures
1330 Alpine meadows
1410 Overgrown areas
1420 Forest plantation
1500 Mixed land use (arable land and forest, small areas)
1600 Uncultivated agriculture land
1800 Forest trees on agricultural land
2000 Forest
3000 Built-up areas and related surfaces
4100 Swamps
4210 Reeds
] 4220 Other marshy areas
5000 Dried open areas with special vegetation
6000 Open areas with little or no vegetation 5

7000 Waters (inland water bodies)



LULUCF .
LULUCF National .
sub- Category description
category class ID
category
[ForesTianplfL [ 2ooofForest ]
CL a 1100|Arable land
CL a 1130|Temporary meadows
CL a 1160|Hop fields
CL a 1190|Green houses
% CL w 1180|Other permanent crops on arable land
< CL w 1211|Vineyards
é CL w 1212|Nursery
o CL w 1221|Intensive orchards
CL w 1222|Extensive orchards
CL w 1230|Olive groves
CL w 1240(Other permanent crops
CL w 1420|Forest plantation
GL a 1300{Meadows and pastures
a GL a 1321|Swampy meadows and pastures
% GL a 1330|Alpine meadows
7 GL a 1600|Uncultivated agriculture land
= GL_w 1410|Overgrown areas
° GL w 1500|Mixed land use (arable land and forest, small areas)
GL w 1800|Forest trees on agricultural land
A WL 4100{Swamps
% WL 4210|Reeds
= WL 4220|Other marshy areas
= WL 7000|Waters (inland water bodies)
SETTLEMENTS |SL 3000|Built-up areas and related surfaces
OTHER LAND oL 5000(Dried open arfeas Yvith special veget_ation
oL 6000|Open areas with little or no vegetation
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LAND USE DISTRIBUTION

SETLLEMENTS
54%

WETLANDS
0.7 %

OTHER LAND
1.5%

GRASSLAND
21.1%

CROPLAND
11.7 %

ALUM, 2012
- L
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LAND USE CHANGE MATRIX

* ALUM (Agricultural land use map)

 VVector data (.shp format) is available for years
2002, 2005, 2009 and 2012
* Accurracy assessment was done for ALUM 2002
* Not for newer editions (€)
* We took the vector data for 2002 and 2012

* Vector to raster
e Reclassification

e Cross-tabulation
S
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VECTOR TO RASTER

* We transformed vector data (.shp) to raster data (.adf)

*In ArcMap (Arcinfo, ESRI)

e ArcToolbox > Conversion tools >
To Raster > Polygon to Raster

e Pixel size: 10 x 10 m
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VECTOR ...
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... TO RASTER
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RECLASSIFICATION

* ArcToolbox > Spatial Analyst Tools >
Reclass > Reclassify

27 national classes to 6 main LULUCF categories

* We divided CROPLAND further to

— cropland annual
— cropland woody

and GRASSLAND to

—grassland annual
—grassland woody

* We established 8 LULUCF (sub)categories
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LULUCF .
LULUCF National .
sub- Category description
category class ID
category
! CL a 1100|Arable land !
CL a 1130|Temporary meadows
CL a 1160|Hop fields
\JCL_a 1190|Green houses Y,
% (ﬁ.:w 1180|0Other permanent crops on arable land
< CLw 1211|Vineyards
é CL w 1212(Nursery
O CL w 1221|Intensive orchards
CL w 1222|Extensive orchards
CL w 1230|0live groves
CL w 1240(Other permanent crops
CL w 1420|Forest plantation
GL a 1300|{Meadows and pastures
a GL a 1321|Swampy meadows and pastures
% GL a 1330|Alpine meadows
7 GL a 1600|Uncultivated agriculture land
% GL w 1410(Overgrown areas
GL_w 1500|Mixed land use (arable land and forest, small areas)
GL_w 1800(Forest trees on agricultural land
A WL 4100{Swamps
% WL 4210[Reeds
= WL 4220|Other marshy areas
= WL 7000|Waters (inland water bodies)
SETTLEMENTS |SL 3000|Built-up areas and related surfaces
OTHER LAND oL 5000|Dried open areas with special vegetation
oL 6000|Open areas with little or no vegetation
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RECLASSIFICATION
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CROSS TABULATION

* ArcToolbox > Spatial Analyst Tools >
Zonal > Tabulate Area

e matrix

to
2002-2012 | FL | €L afct w|GL a[GL w| WL [ SL [ OL  total [ha]
FL
CL_a
CL_w
GL_a
GL_w
WL
SL
oL
total [ha]

from
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LAND USE CHANGE MATRIX

2002-2012

to
2002-2012 total [ha]
FL 714/ 1550 17852 9424 578 5841 2152 38111
CL_a 1286 2899 46268 2587 229 4238) 1 57508
CLw 1317, 1915 11431 1791 23] 20800 0 18558
£ GL_a 19296 21891 8825 22426 750 7930 101 81219
£ GLw 18857 574/ 1217] 8900 607 1451 241 31847
WL 545 143 12) 2167 834 719 192 4613
SL 2470, 1122 5160, 14295 1399 217 46 24708
oL 2792 6 9 5966 1495 118 107 10493
total [ha]|  46563| 26365/19673| 106878 39956/ 2523/22368 2732 267057| ha in 10 years
Land use change matrix in period 13.2 % of the
2002 - 2012, [ha], whole country, ALUM cou ntry area
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LAND USE CHANGE MATRIX

2002-2012

2002-2012 total [ha]
FL 71 155 1785 942 58 584/ 215 3811
CL_a 129 290, 4627 259 23 424 0 5751
CLw 132 192 1143 179 2| 208 0 1856
E GL_a 1930 2189 883 2243 75 793 100 8122
£ GLw 1886 57 122 890 61 145 24/ 3185
WL 55 14 1 217 83 72 19 461
SL 247| 112|516/ 1429 140 22 5 2471
oL 279 1 1 597 149 12 11 1049
total [ha] 4656 2636] 1967 10688 3996 252 2237 273 26706/ ha/ year
Average annual changes, [ha/year], 1.3 % of the

2002-2012, whole country, ALUM country area
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BEFORE 2002 ?

* Survey done at Slovenian Forestry Institute in 2006,
published in 2008 (Kobler et al.)

e ,Downdating” to 1995 and 1986
* 1986 is the base year for Slovenia
* They took the newest available ALUM data (.shp) at that time (2005)
* Then compared ortophoto images from that time
(1986 and 1995) and marked changed polygons

* Survey was done on a sample of randomly chosen

128 blocks of 200 ha
* 25,600 ha = 1.3 % of country area

L
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BEFORE 2002 ?

u
128 blocks of 2 km? ] _Fr
i !I | | ||r|
i S HT 1
B[ 18I T JI.I
I T 1 J|
T "-n i fr : n.ﬂ i B
o T '* P
¥ q.,_.. H ¥l E[F T IEH
: [ EIF' . NEH . 0N 1
i {1 It i .| Fh
TTH s I SIEBI R Rt
I H . 1' N
i ; HHEEEHH
| RLLLEL I
i b
| | LI

= GOZDARSKI INSTITUT SLOVENLIE 13
SLOVENIAN FORESTRY INSTITUTE




BEFORE 2002 ?

* Agregated categories — reasons:

—difficulties distinguising cropland and grassland on old ortophoto images,
—not able to check in field the actual land use,
—budget limitations,

—focusing more on FL (more important in emissions/removals contribution)
and less on not-so-important land uses in terms of biomass present (SL,

WL, OL)
forest land FL
agricultural land CLa+CLw+GL_a

abandoned agricultural land GL_ w
land without vegetation WL+ SL+ OL
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1986 - 1995

abandoned

agricultural | agricultural | land without
SAMPLE forest land land land vegetation |[total

CLa+CL w

1986-1995 FL +GL a GL w WL + SL + OL |[ha]

forest land FL 15286 31 10 17| 15345
agriculturalland |ICL a+CL_ w+GL_a 26 7302 210 32 7570
abandoned
agricultural land |GL_w 458 12 476 1 946
land without
vegetation WL +SL + OL 1 3 13 1706 1723
total [ha] 15771 7347 708 1756/ 25583
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1986 - 1995

SAMPLE forest land |agricultural land  [abandoned agricultural land |land without vegetation |total
1986-1995 FL CLa+CL w+GL a|GL w WL+SL+0L [%]

forest land FL 59,75 0,12 0,04 0,07 59,98
from agricultural land CLa+CL w+GL a 0,10 28,54 0,82 0,12 29,59

abandoned agriculturdGL_w 1,79 0,05 1,86 0,00 3,70

land without vegetati¢{WL + SL + OL 0,00 0,01 0,05 6,67 6,73

total [%] 61,65 28,72 2,77 6,86 100,00
SAMPLE forest land |agricultural land  |abandoned agricultural land |land without vegetation [total

1986-1995 FL CLa+CLw+GL a|GL w WL+SL+0L [ha/year]

forest land FL 3 1 2 6
agricultural land CLa+CLw+GL a 3 23 4 30
abandoned agriculturdGL w 51 1 0 52
land without vegetati{WL + SL + OL 0 0 1 2
total [ha/year] 54 5 26 6 90
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1986 - 1995

to
abandoned
SAMPLE agricultural | agricultural |land without
forest land land land vegetation total
CLa+CL w
1986-1995 FL +GL_a GL w WL+ SL+OL [%]
FL 0,01 0,00 0,01 0,03
from CLa+CL w+GL_a 0,01 0,09 0,01 0,12
GL w 0,20 0,01 0,00 0,20
WL + SL+ OL 0,00 0,00 0,01 0,01
total [%] 0,21 0,02 0,10 0,02 0,35

Average of 0.4 % of sampling area changed in a year
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1995 - 2002

1995-2002 FL CLa CLw |GL a GL w WL |SL OL [total [ha]

FL 15430 8 6 112| 163 2 12| 39 15771
CLa+CLw+GL a 98 2085 574 4283 192 11 96 8 7347

GL w 299 4 9 152/ 181 3 1 61 708

WL +SL+OL 29 12 17 25 11| 99| 903| 658 1756

total [ha] 15856/ 2109 606| 4572 547, 114 1013 766/ 25583
1995-2002 FL CLa CLw|GL a |GL wWL |SL OL total [ha/year]
FL 2204 1 1 16/ 23 0 2 6 2253
CLa+CL w+GL a 14/ 298 82| 612 27 2 14 1 1050
GL w 43 1 1 22 26 0 0 9 101
WL +SL+OL 4 2 2 4 2 14/ 129 94 251
total [ha/year] 2265 301 87 653 78 16/ 145 109 3655
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1995 - 2002

1995-2002 FL CLa CLw|GL a |GL wWL |SL OL total [ha/year]

FL 60,3 00 00 04 06 00 0,0 0,2 61,6
CLa+CLw+GLa 04 81 22 16,7 0,77 00 0,4 0,0 28,7
GL w 1,2l 00 00 O6 0,7 00 0,0 0,2 2,8
WL +SL+OL o1 00 01 01 00 04 35 26 6,9
total [ha/year] 62,0 8,2 24 17,9 2,1 04 4,0 3,0 100,0
1995-2002 FL CLa CLw GLa [GLw WL SL OL total [%]

FL o0 o0 01 0,21 00 00 0,0 0,2
CLa+CLw+GL a 0,1 o1 0,0 01 o0, 0,2
GL w 0,2 00 00 01 00 0,0 0,0 0,3
WL+SL+OL 00 00 00 00 0,0 0,1
total [%] 02 00 00 02 02 00 0,1 01 0,8

Average of 0.8 % of sampling area changed in a year
=
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1986-2012

1986 | 1995
aggregated categories [%] [%]
forest land FL 58,61 59,99
agricultural land CLa+CLw+GL a|l 32,00 30,96
abandoned agricultural land GL_w 2,04 1,56
land without vegetation WL + SL+ OL 7,35 7,49

total 100,00 100,00
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1986-2012

e With auxilliary data (Statistical Office of RS)
 We were able to calculate distribution (%) of all land

uses for 1986, 1995, 2002 and 2012

[%]
LULUCF category 1986 1995 2002 2012
FL 58,66 60,0 59,3 59,7
CL_a 8,0 8,3 10,7 9,1
CL w 2,2 2,2 2,6 2,6
GL a 21,8 20,4 17,3 18,4
GL w 2,0 1,6 2,2 2,7
WL 0,8 0,8 0,8 0,7
SL 5,1 52 5,3 5,4
OL 1,5 1,5 1,9 1,5
total [%] 100,0 100,0 100,0 100,0

e i
S
7

bl +
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DEFORESTATION

2002-2012
FL
- d I:
|CL_W 1317} 1915 11431} 1791 23| 2080 0 18558
g|GL_a 19296| 21891| 8825 22426/ 750 7930 101 81219
+ GL_w 18857 574 1217, 8900 607 1451 241 31847
WL 545 143 12| 2167 834 719 192 4613
SL 2470, 1122| 5160 14295 1399 217 46 24708
oL 2792 6 9 5966| 1495 118 107 10493
total [ha] 46563 26365| 19673 106878 39956, 2523| 22368 2732 267057

38 kha in 10 years ?!? (1.9 % of country area, 3.2 % of Slovenian forests)
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DEFORESTATION

* Land use change matrix from ALUM in time period 2002 —
2012 (38,111 ha, 1.9 % of the country area), average 3,811 ha

per year

* For every change of forest to any land use, the owner must
get a permit from Slovenia Forest Service

» Official data from Slovenia Forest Service in time period 2002
— 2011 (4,418 ha, 0.2 % of country area), average 491 ha per
year

* The difference is almost 10x !

29
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DEFORESTATION

* We took vector data on forest (category 2000 in
ALUM)

* Polygons — where forest was in 2002, but isn‘t in
2012 (app. 38 kha)

* By legislation, difference of 15 m between ALUM and
management plans is allowed

e Buffer of 15 m was eliminated (remaining
deforestation area was 12kha, 0.6 % of country area)
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DEFORESTATION

* On remaining area, app. 1200 polygons was checked
on ortophoto images for both years

* 50 polygons per category, 100 polygons in larger
categories

* After visual check of real changes of forest on
ortophoto images, the assessment of actual
deforestation was 5,491 ha (0.3 % of country area),
average 549 ha per year

 Comparison: official data — average 491 ha

LUC matrix — average 3,811 ha
e e e e
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CONCLUSION

e We have all this data available...

* How to implement it in CRF and NIR?

e if we use LUC matrix 2002-2012 for whole time period — we
come to some absurd situations / numbers (i.e. GL_woody
area, deforestation — emissions of 1,600 GgCO, etc.)

* |f and how to report emissions/removals by aggregated
categories?

3}
*
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Thank you for your attention!

£ GOZDARSKI INSTITUT SLOVENLE 33
SLOVENIAN FORESTRY INSTITUTE




